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1 Introduction

The first section in this Getting Started manual discusses the installation of FEKO under
MS Windows on PC’s and on UNIX workstations. Note that the graphical user inter-
face (CADFEKO, EDITFEKO and POSTFEKO) is currently only available under MS
Windows and Linux.

The next sections discuss a number of simple step-by-step examples designed to guide the
user through the process of:

• Creating geometry in the CADFEKO user interface.

• Setting the appropriate electromagnetic parameters in the EDITFEKO user inter-
face.

• Solving the electromagnetic problem at hand.

• Using the POSTFEKO user interface to view the model and plot solution data.

This guide contains three examples:

• The first example introduces all the components of FEKO and the basic solution
process. A model of a horn antenna is distributed with the FEKO suite. This model
is discussed and instructions are given for the extraction of results from this model.

• In the second example we introduce symmetry and labels and look at some mesh
requirements. The second example shows the development of a FEKO model of a
patch antenna on a finite sized substrate. Dielectric regions and local mesh para-
meters are set for this example.

• The third example considers a simple EMC type problem and demonstrates how to
set up a model in the presence of a ground plane.

These examples present a very basic introduction to FEKO. The FEKO User’s Manual
should be consulted for a broader presentation of all the features available in FEKO. (It
can be found in the doc directory under the FEKO installation directory, or in the doc
directory on the FEKO CD and can be viewed and printed with the Adobe Reader — see
section 2.6.) New users should read at least the General comments section of the User’s
Manual.

Other simple examples which illustrate certain features of FEKO are discussed in the
FEKO Examples Guide which may be found in the same location as the User’s Man-
ual. The input files for these examples are available in the examples\CAD_input and
examples\text_input directories, respectively, under the FEKO installation directory.
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1-2 INTRODUCTION

1.1 FEKO components

This section gives a quick overview of the various FEKO components and their availability
on the various platforms. Presently both pre- and post processing have to be done under
MS Windows or Linux.

• The CADFEKO interface is used for geometry specification and mesh generation.

• The electromagnetic parameters are set in the EDITFEKO interface, which provides
a user friendly interface to the input cards required by FEKO.

• Both the solution kernel, FEKO, and the preprocessor/mesher, PREFEKO, as well
as the adaptive frequency component, ADAPTFEKO, are available on all supported
PC and workstation platforms.

• The POSTFEKO interface is used to display the model and all the results of the
simulation.

• The support components, OPTFEKO and TIMEFEKO — used for optimisation
and time domain analysis respectively — are available on all supported PC and
workstation platforms.

1.2 Using FEKO LITE instead of the full version

FEKO can be run in a mode called FEKO LITE . This is a limited version of the FEKO
suite. All the components of the suite, from the graphical user interfaces to the solver, are
limited in capability when running in this mode. Note that the LITE version of FEKO
is not an evaluation version! An evaluation licence will allow the unlimited use of FEKO
for 30 days. If you are considering the purchase of FEKO, please contact your distributor
for an evaluation licence.

A licence is required to run FEKO in LITE mode. If no licence is present, FEKO will
run for a period of 30 days. The FEKO licence is stored in the file secfeko.dat in the
license subdirectory of the FEKO installation.

A licence for the FEKO LITE mode can be requested from the FEKO website. The
licence that will be provided will expire after 6 months, at which time a re-registration
is required. Once the registration from is filled in, it will be submitted to the distributor
for your region for processing. Once the request is processed, a licence file will be sent to
you via email.

You can register your copy of FEKO LITE at

www.feko.info/register lite
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INTRODUCTION 1-3

FEKO LITE is limited with respect to problem size and can therefore run only about
half the examples in the FEKO Examples Guide. The examples in this guide were chosen
with this in mind and only the last two examples need some modification to run them
with FEKO LITE. Only the final example in this guide can be run in FEKO LITE mode,
with some minor modification.

1.3 Installing the full version after using FEKO LITE

If you have an installation of FEKO LITE, switching to the full version is simple. (Note
that the evaluation version is a full version which is limited only in the period for which it
can be used.) In order to create a FEKO licence for a computer, some information about
that computer is required. Execute the script request.bat in the bin subdirectory of
the FEKO installation. This creates a file request in the license subdirectory. Edit
this file to enter the information requested at the top of the file and email or fax the file
to your distributor. You will then receive a file secfeko.dat which you must copy to the
license subdirectory of the FEKO installation (overwrite any existing files).

1.4 Contacting your distributor or EMSS

You can find the distributor for your region at

www.feko.info/contact.htm

Alternatively, for technical questions, please send email to

feko support@emssusa.com for North America
feko support@emss.de for Europe
feko support@emss.co.za for all other regions

or, for activation codes and licence queries, to

feko license@emssusa.com for North America
feko license@emss.de for Europe
feko license@emss.co.za for all other regions

1.5 Updates to the documentation

Changes in this manual with respect to the previous one of July 2005 (Suite 5.0) are
indicated as follows:
Sections that have changed from those in the previous version of the manual.
Sections that were newly added to this version of the manual.
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2 Installation of FEKO

2.1 Introduction

This section describes the installation procedures for FEKO on PCs and workstations.
You should be able to install the software successfully by following the on-screen instal-
lation instructions. However, it is recommended that you work through the installation
procedures described here. If you have technical questions, please contact your distributor
(see section 1.4).

The PC installation is for Windows NT/2000/XP (Windows 98 and ME are no longer
supported). The workstation installation is for any of the major UNIX workstation plat-
forms, including HP, SGI, SUN and Linux. An efficient parallel version of FEKO is also
available on all these platforms (Windows, Linux and UNIX).

The installation copies the FEKO manuals to the doc subdirectory. These manuals are
in PDF format and a PDF viewer, for example the Adobe Reader, is required to view
them. The installation of the Adobe Reader is discussed in section 2.6. On MS Windows
systems the FEKO installation configures the GUI components to use the default PDF
viewer, hence the PDF viewer should be installed before FEKO. (It is, of course, possible
to configure the PDF viewer in the GUI components if it is installed / updated after
installing FEKO.)

2.2 MS Windows installation

Unless you install the 30-day unregistered version of FEKO LITE, FEKO requires a
licence file (see section 2.2.5). FEKO can only be installed on Windows NT/2000/XP
machines by a user with administrative rights. The parallel version must be installed
separately — in the same directory — on each PC in the cluster. In addition you must
have an account with the same password on all the PCs you want to use.

There are three different ways to install FEKO:

• Graphical interactive mode
• Silent mode using the installation executable
• Silent mode using the embedded Microsoft Installer database

Note that using the silent installation to install the parallel solver is not recommended, be-
cause the silent installation does not perform all the necessary setup steps (some steps al-
ways require user input). FEKO will be installed, but the configuration must be completed
on all machines in the cluster. This can be done by editing the file machines.feko (located
in %FEKO_HOME%\mpi\shares) and running mpiregister.bat (in %FEKO_HOME%\mpi\bin)
on all the target machines.

After completing the installation, the examples in the remaining sections of this manual
should be consulted for a step-by-step introduction to the basic operation of FEKO.
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2.2.1 System requirements

The following are the minimum requirements for the Windows installation:

• An IBM compatible PC with a Pentium or higher processor.
• Operating system MS Windows NT 4.0/2000/XP.
• 100 MByte free hard disk space (120 MByte for the parallel version).
• 256 MByte of free base memory, more memory is required to solve large problems.
• The GUI components were designed for a screen resolution of 1024×768 (using small

fonts) or larger. Lower resolutions may result in truncated dialogs.
• A colour depth of 256 colours is required, but more colours are preferred.

2.2.2 Installing FEKO

There are two FEKO installations for MS Windows

Platform Filename

32-bit Intel or compatible feko distrib xx.yy win32.tar.gz

64-bit on Intel Itanium, Intel EM64T
or AMD Opteron

feko distrib xx.yy win64.tar.gz

where the xx.yy in the filename indicates the FEKO Suite number. The 64-bit installation
automatically detects the platform and installs the correct version of the executables.
Note that it installs 32-bit versions of the GUI components. The GUI will therefore
run in emulation mode on Intel Itanium systems — its performance will be somewhat
degraded. It is also, of course, possible to install the 32-bit version on a 64-bit system,
but then the 32-bit limits (such as allocating a maximum of 2 GByte RAM) still apply.
Hence one would not normally do this, especially on Intel Itanium systems.

If you have downloaded the installation executable, copy it to a temporary directory on
your hard drive and execute it.

If you have a FEKO CD, insert it into your CDROM drive. The FEKO installation
program should start automatically. (If not, execute startup.exe in the root directory
of the FEKO CD.) Click Install 32-bit FEKO (“Silver” licence) to install the 32-bit
version or Install 64-bit FEKO (“Gold” licence) for the 64-bit version. (The different
licences relate to the pricing structure. If you are uncertain of your licence type, please
contact your distributor.) Note that the Install 64-bit FEKO button will be disabled
when running on a 32-bit system. If this button is disabled in error, the installation
executable can be found in the installs\windows directory.
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• You must uninstall any existing versions of FEKO (prior to version 5.0) before con-
tinuing. If you have FEKO 5.0 or later installed, the installation will automatically
upgrade your existing installation. (All user and licence files will be retained.)

• The Select features page controls what is installed. FEKO (Solver and GUI) must
be selected if this PC will be used to setup and solve FEKO models.

If this PC is part of a windows cluster that is intended to run the parallel verion of
FEKO, the Include parallel solver option must be checked. FEKO must be installed
separately — in the same location — on all the PCs in the cluster.

Select Install as FEKO LITE to install a limited version which can be used for 30
days without a licence. After 30-days you need to register FEKO LITE or switch
to a full version. (See section 2.2.5 below.)

If you purchased floating licences, you must install a Floating licence server on one
sever in your network (see section 2.4).

• The Choose a scratch directory page allows the user to determine where FEKO
writes temporary files during the out-of-core solution. This should be a directory
which can accommodate very large files. This path is stored in the environment
variable FEKO_TMPDIR which may be modified if the temporary files should be writ-
ten to a different location (such as when a second hard disk is used to provide larger
scratch space).

• FEKO can be configured by setting certain environment variables. (See the General
comments chapter of the main FEKO manual.) The installation already sets the
most common of these.

• During setup a number of examples are copied to the subdirectory examples under
the FEKO installation. These may be used to test your FEKO installation and
to provide examples of the various FEKO features. (For more detail consult the
Examples Guide which may be found in PDF format in the doc subdirectory of the
FEKO installation directory.)

2.2.3 Installing FEKO in silent mode using the installation executable

The FEKO installer for Windows can also be installed in silent mode. This mode is used
to install FEKO without manually going through the installation dialogues.

• To use the installer in silent mode, a response file must first be created. The
response file only needs to be created once, and can then be used on all the target
machines. The FEKO CD contains a template response file called setup.iss. This
file is located in the installs\windows directory on the CD. Copy this file to a
temporary location on the target computer’s hard drive. This file contains the
header information required by the installer when running in silent mode.
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• The next step is to run the installer in record mode. Launch the installer as follows:
feko_distrib_xx.yy_winNN.exe /r /f1"C:\Temp\setup.iss"
where "C:\Temp\setup.iss" specifies the absolute path to the setup.iss file. This
will launch the installer in record mode and record all the steps followed (selecting
installation directory, installed components etc.). Note that this will install FEKO
on the computer that is used to create the response file.

• The completed setup.iss file can now be copied to all the target machines. To
install FEKO in silent mode on a target machine, launch the installer as follows:
feko_distrib_xx.yy_winNN.exe /s /f1"C:\Temp\setup.iss"
where "C:\Temp\setup.iss" specifies the absolute path to the setup.iss file.

2.2.4 Installing FEKO in silent mode using the MSI database

The last mechanism provided to install FEKO silently uses the embedded MSI file directly.

• The FEKO installer (feko_distrib_xx.yy_winNN.exe) contains a MSI database.
This must first be extracted before it can be used. To extract the MSI data-
base, launch the FEKO installer normally (i.e. by double-clicking it or just typ-
ing feko_distrib_xx.yy_winNN.exe at a command prompt). When the welcome
screen is displayed, click the “Cancel” button and abort the installation. The FEKO
MSI database can then be found under %WINDIR%\FEKO Installations\{GUID}\.
Copy this file to all the target machines. Note that FEKO is NOT installed on the
machine that the file was extracted on.

• On the target machines, open a command prompt and change directory to the
location of the MSI database. Then launch the Windows installer as follows:
msiexec /i "FEKO x.y.msi" /qb+ [variables] where [variables] must contain

– INSTALLDIR="C:\FEKO" : The path where FEKO must be installed.

– FEKO_USER_HOME="C:\FEKO" : The location of the FEKO user files.

– FEKO_TMPDIR="C:\Temp" : The path to the directory where FEKO will store
temporary files.

– FEKOLANG="e" : The language used by FEKO when creating output files; spec-
ify ”e” for English or ”d” for German.

– FEKO_SILENT="1" : This must be specified in silent MSI mode.

– ADDLOCAL="Default,..." : The features to install. Specify any of the follow-
ing items (with ”Default”) in a comma-separated list: FEKOKernel, Parallel,
FEKOLITE or FloatingLicence. Note that you must not specify FEKOLITE
and FloatingLicence together.

Note that you may also specify /qn, /qn+ or /qb instead of /qb+.
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2.2.5 Obtaining the FEKO licence file

The installation program should have created the file request in the license subdirectory
of the FEKO installation. If it does not exist, this file can be created by executing
request.bat in the bin subdirectory of the FEKO installation.

Edit the file — enter the information requested at the top thereof — and email or fax it to
your distributor (see section 1.4). You will then receive a licence file secfeko.dat which
must be placed in the license subdirectory of the FEKO installation to activate your
licence. (You can run an unregistered version of FEKO LITE — the GUI components
will switch automatically if no licence is found — for a period of 30 days until you obtain
this file. After 30 days you also need a licence file to run FEKO LITE.) If you are
using floating licences the procedure is the same, but you may need to edit this file, see
section 2.4).

If you want to switch to an evaluation version after running FEKO LITE, you need to
create and send the request file to your distributor as mentioned above. Then overwrite
the existing file secfeko.dat with the new one obtained from your distributor.

2.3 UNIX / Linux workstation installations

To install FEKO on a UNIX or Linux workstation (both parallel and sequential versions)
the FEKO installation script must be executed, see below for detailed instructions. Note
again that the pre- and post processing support components are currently only available
on Windows or Linux PCs.

2.3.1 Supported platforms

The workstation platforms currently supported are summarised below. A parallel version
of FEKO is available for all these platforms. For FEKO on other workstation platforms
please contact your distributor. The indicated filename is relevant only if you are not
installing directly from the FEKO CD. The string xx.yy in the filename indicates the
FEKO Suite version.

Platform Filename

Linux (32-bit Intel or compatible) feko distrib xx.yy LINUX.tar.gz

Linux (64-bit on Intel Itanium) feko distrib xx.yy LINUX IA64.tar.gz

Linux (64-bit on Intel EM64T) feko distrib xx.yy LINUX EM64T.tar.gz

Linux (64-bit on AMD Opteron) feko distrib xx.yy LINUX AMD64.tar.gz

HP-UX (64-bit on Intel Itanium) feko distrib xx.yy HP IA64.tar.gz

HP-UX (64-bit on HP PA 2.0) feko distrib xx.yy HP.tar.gz

SGI IRIX (n32- and 64-bit) feko distrib xx.yy SGI.tar.gz

SUN Solaris (32- and 64-bit) feko distrib xx.yy SUN.tar.gz
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2-6 INSTALLATION OF FEKO

If downloading the installation files or manually copying them from the FEKO CD, then
in addition to the platform dependent file listed in the table above, you will also need the
documentation and examples which are available in the file

feko_distrib_xx.yy_documents.tar.gz

If installing under Linux (32- or 64-bit) then the corresponding GUI executables and help
files are required from the packed archive

feko_distrib_xx.yy_LINUX_GUI.tar.gz

See the following section for detailed installation instructions.

2.3.2 Installation

The following procedure can be used to install FEKO on a new workstation or to perform
an update of an existing installation (in the case of an update, a backup of the old
installation is created automatically). If you have technical questions, please contact
your distributor (see section 1.4).

• The default FEKO installation path is /opt/feko. Of course any other directory
can be specified during the interactive installation process. Make sure at this stage
that you have write permissions on the directory where you want to install FEKO.
In most situations, one might now have to change to the root user, in particular if
FEKO shall be installed in a global directory accessible by more than one user.

• For the next step, we distinguish between three different situations:

a.) You have received FEKO on a CD, and the workstation where you want to
install FEKO has a CDROM drive. Then you can install directly from the
CD. Load the CD on this workstation and mount it. The command for this is
system dependent, for example

mount /dev/hdc /mnt/cdrom

(check for your system). It is assumed that the CD has been mounted to
/mnt/cdrom, then simply execute now the FEKO installation script

cd /mnt/cdrom/installs/unix
sh ./INSTALL.SH

which will guide you step by step through the installation process. Note that
the mount options may influence the case of file and directory names — please
use ls to determine the case of the directory and file names if it is not the
same as above. (The installation script will account for both cases.)
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b.) If you have received FEKO on a CD, but cannot read the CD from your work-
station, then copy the appropriate *.tar.gz file for your platform (see table
in section 2.3.1, e.g. feko_distrib_xx.yy_LINUX.tar.gz for the FEKO Suite
xx.yy for Linux PCs) from the subdirectory installs/unix/archives on the
CD to a temporary directory on the workstation (you may temporarily need up
to 390 MByte of disk space there). This can be done for instance by reading the
CD on a PC, and transferring the file by ftp (binary mode) to the workstation,
or by using a shared network drive. Also copy the FEKO example and doc-
umentation files from the CD (file feko_distrib_xx.yy_documents.tar.gz
with the Suite number xx.yy in the same directory installs/unix/archives)
to this temporary directory. If installing on a Linux PC, then also copy the
GUI archive feko_distrib_xx.yy_LINUX_GUI.tar.gz there. Now follow the
instructions in the next paragraph c.

c.) If you have not received FEKO on a CD, but rather the installation file (e.g.
feko_distrib_xx.yy_LINUX.tar.gz for Suite xx.yy for Linux PCs) directly
by email or WWW download, then put this file to a temporary directory on
your workstation (you may temporarily need up to 390 MByte of disk space
there). In the following it is assumed that this directory is /tmp. Also put
there the file feko_distrib_xx.yy_documents.tar.gz in order to install the
FEKO examples and documentation. If installing under Linux, you also need
to get the GUI archive feko_distrib_xx.yy_LINUX_GUI.tar.gz.
Then proceed as follows (this is an example for 32-bit Linux PCs, substitute
the correct filenames for your platform and note again that the GUI is available
only for Linux, i.e. skip the second file if installing say on an HP workstation):

cd /tmp
gunzip -c feko_distrib_xx.yy_LINUX.tar.gz | tar -xf -
gunzip -c feko_distrib_xx.yy_LINUX_GUI.tar.gz | tar -xf -
gunzip -c feko_distrib_xx.yy_documents.tar.gz | tar -xf -
cd feko_install
sh ./INSTALL.SH

This will start the installation script, follow the online instructions, which will
guide you step by step through the installation process.
Once the installation is finished, the temporary files in /tmp/feko_install
can be deleted again, see also instructions given to you online.

• Note that before FEKO can be used on the workstation, certain environment vari-
ables must be set. To this end a shell script initfeko will be created during the
installation, which can be found in the subdirectory bin of the FEKO installation
tree, e.g. /opt/feko/bin. See the instructions given on the screen of how this file
must be executed (it can, for example, be inserted into your personal startup file
$HOME/.profile or $HOME/.bash_profile). This initialisation script initfeko is
intended for the ksh, bsh, sh, and bash shells.
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2-8 INSTALLATION OF FEKO

A similar script initfeko.csh is created (also in the subdirectory $FEKO_HOME/bin)
for the C-Shell (i.e. csh, tcsh). For an automatic execution, please execute this script
from the personal startup files $HOME/.login or $HOME/.cshrc.

• The installation script will create a file request in the subdirectory license un-
der the FEKO installation directory (e.g. /opt/feko/license/request). Some
updates will require a new password file. (FEKO will then give a message if the
password file is no longer valid if you run it after the installation.) If this is the
case, or if this is a new installation, please email or fax the request file to your
distributor (see section 1.4).

You will then get a file secfeko.dat with the passwords for your workstation (or
for a parallel machine for all nodes of the cluster). This file secfeko.dat must
be put into the license subdirectory of the FEKO installation directory, see also
detailed instructions with the full path for your specific setup in the file request
and on the screen during the FEKO installation.

2.4 Floating licences

By default FEKO uses a node locked licence scheme. From FEKO Suite 4.2 a floating
licence scheme is also available. This whole section 2.4 is only relevant if you purchased
this separate licence option, otherwise it can be skipped.

2.4.1 Concept of floating licences and general comments

The concept of floating licences is quite simple. A floating licence server is chosen, which
manages the FEKO licences. This server machine should be a reliable machine running
more or less permanently, without being rebooted too often (it can be rebooted, but any
FEKO jobs running at that time even on remote client machines will then be terminated).

At the time of installation (see separate details below for UNIX and Windows) only the
request file of the floating licence server needs to be sent to EMSS in order to create a
licence file secfeko.dat. The client machines can be chosen arbitrarily, but need to have
a permanent network connection to the floating licence server (i.e. a notebook computer
cannot act as a client if FEKO shall be used on this while for instance travelling. For
such cases, EMSS also offers special licences locked to a dongle).

The obtained licence file secfeko.dat must be copied into the subdirectory license of
your FEKO installation. This must also be done to all client machines, so that they know
which floating licence server to contact (hostname or IP address) and which TCP port to
use for the communication. This information is in the header section of the licence file
and can be edited:
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############### START USER EDITABLE SECTION ###############

# Specify here your licence server, either using the hostname

# or the IP address (from each client you must be able to reach

# the server in this way, if you have problems try "ping"

# with exactly the hostname or IP address you have specified

# below after the SERVER keyword).

SERVER machine.domain.xx.yy

#

# Specify here the TCP port number that should be used for the

# communication between clients and server. Leave the default

# if you are unsure. If you get an error message that the port

# is in use you will have to change.

PORT 11601

############### END USER EDITABLE SECTION ###############

Note that while you can edit the SERVER hostname or IP address, you cannot move the
floating licence server to another machine without first having sent the request file of
this machine to your distributor and having obtained a new valid licence file secfeko.dat
for the new licence server machine.

An arbitrary TCP port can be selected, by default FEKO uses 11601. Note that when
editing the port information, this must be the same on the client and the server side.
Also when changing the port on the server side, don’t forget to restart the floating licence
server so that this change comes into effect.

Such management tasks like restarting the floating licence server can be accomplished by
a graphical utility secfeko_gui (see FEKO User’s Manual for details) or by using the
command line utility secfeko. Just type secfeko in a command or shell window to get a
syntax overview. Restarting the floating licence server can be done for instance by using
the command secfeko -r.

2.4.2 Floating licence server installation and maintenance (Windows)

Under MS Windows, the floating licence server must be installed on a machine running
Windows NT or 2000 or XP. Note that administrative rights are required during the
installation (the FEKO floating licence server secfekod.exe will be installed as a service
under the SYSTEM account).

Follow the standard installation instructions under Windows. On the Select features page,
Floating licence server must be selected. You may or may not install the solver and GUI
on the licence server, but you cannot install FEKO LITE and the floating licence server
on the same PC.

A request file will be created during each FEKO installation. Please send this request
file of the server (and not the ones of the client machines) to EMSS. See section 2.2.5 for
details.
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Once you have obtained the FEKO licence file secfeko.dat and copied this into the
license subdirectory of your FEKO installation, the floating licence server must be
started. Do this either from a command window by typing

secfekod --start

or from the programme menu under Settings - Control Panel - Administrative Tools -
Services and there in the list right click on the service FEKO floating licence manager
and select Start. In a few cases this operation may not be successful. Then the licence
server must be rebooted.

From this service menu under Windows the floating licence server can also be stopped in
the same way. When using the command line interface, the corresponding call is

secfekod --stop

to stop the service. With

secfekod --remove

the floating licence server will be stopped if it is running, and the service removed (but
it will not be removed from the hard disk). To install it again as a service, use

secfekod --install

These two last options should normally not be required, but are listed for completeness.

Once you have obtained the licence file and started the floating licence server, it is a good
idea to check its proper operation by starting secfeko_gui (see FEKO User’s Manual
for more details on this). It should then connect to the floating licence server and obtain
a list of the floating licences and show their status (available versus in-use etc.).

All error messages that the floating licence server encounters are written to the system
event log facility, which can be viewed from the Control Panel - Administrative Tools -
Event Viewer - Applications. In this event log the name secfekod is used as source, and
not only errors are logged, but also startup and stop notices.

All errors of the floating licence server are also written to a file licence.error in the sub-
directory license of the FEKO installation. The error descriptions should be relatively
clear, in case of problems please contact FEKO Support (see section 1.4 for details) with a
problem description and the error number (preferably send the complete licence.error
file as an e-mail attachment).

One potential problem shall be mentioned here: Under Windows XP one can activate
an internet connection firewall for network connections under the advanced TCP/IP net-
working settings. If this firewall is active on the floating licence server, then in the default
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configuration, incoming connections to the chosen TCP port (see comment above, by
default 11601) will be blocked and clients attempting to connect to the floating licence
server will terminate with a suitable error message. In this case please configure the
firewall such that incoming connections on this TCP port are allowed from your domain
(add a specific service secfekod to the firewall settings, see the Windows documentation
on how to do this).

2.4.3 Floating licence server installation and maintenance (UNIX)

Under UNIX, perform a standard installation of FEKO on the machine that shall act as
a floating licence server and on all the client machines where FEKO shall be used, see
section 2.3.

A request file will be created during the FEKO installation, and please send this request
file of the server (and not the ones of the client machines) to EMSS. See section 2.2.5 for
details.

Once you have obtained the FEKO licence file secfeko.dat and copied this into the
license subdirectory of your FEKO installation (on the server machine but also on all
the client machines), the floating licence server must be started. To this end three different
startup scripts have been created during the FEKO installation process in the directory
$FEKO_HOME/bin:

secfekod init.SuSE for SuSE Linux
secfekod init.RedHat for RedHat Linux
secfekod init.generic a generic script e.g. for HP-UX

Please check the setting of the variable FEKODIR in the appropriate file for you to match
the FEKO installation directly, and then copy this file to the general daemon startup
directory such as /etc/init.d/ by using the for instance for SuSE Linux the command

cp $FEKO_HOME/bin/secfekod.init_SuSE /etc/init.d/secfekod

Register this service by using the suitable system command, e.g.

insserv secfekod

for Linux, so that it will be started automatically at the next time you boot your machine.
For the first time now manually start the daemon using the command

/etc/init.d/secfekod start
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This will start the floating licence server as a background process. This is the recom-
mended way of operation, but root privileges will be required. Should this not be de-
sired, one can also just start the FEKO floating licence server in an interactive mode
(use $FEKO_HOME/bin/secfekod -i) or as daemon (use $FEKO_HOME/bin/secfekod -d)
under any user account.

Once you have started the floating licence server, it is a good idea to check its proper
operation by starting secfeko_gui (see FEKO User’s Manual for more details on this). It
should then connect to the floating licence server and obtain a list of the floating licences
and show their status (available versus in-use etc.).

This utility secfeko_gui is not available yet for all UNIX platforms. If not available,
then use the command

secfeko -p

to retrieve and display such licence usage information.

In case of any errors: In the interactive mode (see startup option -i mentioned above)
error messages that the floating licence server encounters are written to the console to
stderr.

When running secfekod as a daemon (default and recommended), then all error messages
are written to the system event log facility, typically this is the file /var/log/messages.
All startup and stop notices are also logged there.

For the daemon mode, all errors of the floating licence server are also written to a file
licence.error in the sub-directory license of the FEKO installation. The error de-
scriptions should be relatively clear. In case of problems please contact FEKO Support
(see section 1.4 for details) with a problem description and the error number (preferably
send the complete licence.error file as an e-mail attachment).

2.5 Setup of remote launching

A remote launching facility is available in FEKO so that for instance sequential or parallel
jobs on a workstation or parallel cluster can be launched from a local desktop PC.

It is suggested that new users first install FEKO locally and familiarise themselves with
FEKO. Then this section can be skipped. One can later came back to setup the remote
launching if this is desired.

For the remote launching in FEKO, there is no need for the file systems to be shared,
all the file copy operations are performed automatically. Also the progress of the remote
run (including warning or error messages) can be monitored locally, similar to launching
the job locally. This remote launching is also cross platform, one can for instance launch
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a remote job from a Windows PC on a Linux cluster or on an HP workstation, but also
from Linux to Linux, or even from a SUN workstation to a Windows PC etc.

The requirements and setup of this remote launching facility shall be described here:

• FEKO must be installed on both the local client and the remote host. Also valid
FEKO licences must be available on both computers. When using floating licences,
two separate licences will be required, one for the client and one for the remote host.
It is, however, possible to use a local GUI–only licence to launch a full FEKO job
elsewhere.

• The remote launching and file copy operations are based on the SSH protocol.
Thus an SSH client must be installed on the local machine and an SSH server
must be running on the remote host. For UNIX / Linux machines this is typically
readily the case. If not, one implementation is OpenSSH which is available from
http://www.openssh.com.

For Windows clients different SSH implementations exist (e.g. CYGWIN or PUTTY).
For Windows servers CYGWIN can be used (see http://cygwin.com)

• On the client the ssh and scp executables must be in the local PATH.

• Public key authentication must be used. If this has not yet been setup, do this:

– If a private/public key pair has not yet been created on the client (check for
files $HOME/.ssh/id_dsa*), then run

ssh-keygen -t dsa -N ""

in order to create such a public/private DSA key pair.

– In the local directory $HOME/.ssh a file id_dsa.pub is then created. Copy
this to the remote host and there append to the file authorized_keys in the
$HOME/.ssh directory there (create this file if it does not exist).

• Verify that SSH is working with public key authentication. Type on the client

ssh remote_host ls

where remote_host is the hostname or IP address of the remote host to be used.
This should give a listing of the files in the home directory on the remote host. If
not then the error message should give an indication what is wrong. One can also
create debug output using the verbose option -v as follows:

ssh -v remote_host ls
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• On the remote host the FEKO environment must be set properly. Verify this with

ssh remote_host prefeko

If the executable prefeko is not found, then the environment variables as defined in
$FEKO_HOME/bin/initfeko are not available. When using for instance the BASH
shell on the remote host, make sure to add a line

. /opt/feko/bin/initfeko

(note the dot followed by a space) to your .bashrc file (adding this to .bash_profile
as for a normal FEKO installation will not work since SSH opens a non-interactive
shell only). Also note that the path /opt/feko/bin might be different for your
FEKO installation.

• On the remote host the utilities mkdir (to create directories) and rm (to delete files)
must be available. For UNIX / Linux this is the case, when using a Windows server
these can be installed as part of CYGWIN (see above).

After these initial setup steps, remote FEKO jobs on other computers can be launched.
Please see the FEKO User’s Manual for further usage instructions, both from within the
FEKO GUI and also from the command line.

Advanced users or system administrators might deviate from the setup procedure as
described above. For instance, if public key based SSH authentication cannot be used
but something else is available (like the insecure rsh with rcp for the file copy operations),
then the corresponding FEKO remote launching scripts can be customised. For Windows
this is the batch file feko_remote.bat and for UNIX installations of FEKO this is the shell
script feko_parallel, both residing in the bin subdirectory of the FEKO installation.
Please see the comments in these files. Note, however, that when updating FEKO any
changes made to these files will be overwritten, so make a backup copy and keep at a safe
place.

2.6 Adobe Reader installation

A PDF viewer is required to view and/or print the Getting Started Manual, the Examples
Guide and the FEKO User’s Manual that are available on the FEKO CD in the doc
directory (and are installed in the doc subdirectory under the FEKO installation).

The Adobe Reader 7.0 can be downloaded from

http://www.adobe.com/products/acrobat/readstep.html
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3 Getting started example 1: Rectangular Horn ex-
ample

The first example makes use of an already set up and solved model of a horn antenna to
familiarise the user with the FEKO program flow. The discussion assumes that this is
read after the demo has been watched. If this is not the case, it is strongly recommend
that the demo be watched before working through this example. (The demo example
is the short movie of the solution of a horn antenna that is shipped with the FEKO
installation.) The demo can be found in the doc subdirectory of the FEKO installation.
For Windows installations, this file is an .exe file, which can be executed directly. On
Linux installations, the demo is opened inside an .htm file.

3.1 Example overview

This example uses the same antenna as the demo example. The geometry is that of a
rectangular horn with a probe feed in a short waveguide section. ( Please refer to the text
example example_08 for a discussion of ways to feed a horn with a waveguide excitation. )
The demo example shows the construction of the horn, the specification of the excitation,
and the request of the near and far field patterns and basic display of the results. This
example concerns itself with the reinforcement of the program model and the use of the
different FEKO components. This example should take 30 minutes to work through.

The example is already set up and solved, and can be found in the examples\projects\horn
directory of the FEKO installation. It is expected that while working through this text,
the steps are followed sequentially. As far as is possible, the example is designed such
that steps are independent of order, but it is not always possible to achieve this. If an
explanation seems out of context, it might depend on a previous step.

3.2 Creation of the geometry in CADFEKO

The first step in every FEKO solution is to construct the geometry. The geometry is
created by the component CADFEKO and stored in the *.cfx file. To start CADFEKO
from the Windows Start menu, choose

Programs → FEKO → CADFEKO
or open a console window and type cadfeko.

From the main menu in CADFEKO select File → Open and select the file horn.cfx in
the examples\projects\horn directory of the FEKO installation. The geometry of the
horn is now visible on the screen. The CADFEKO interface has a Windows look and feel,
which should be familiar to most users.
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There are a number of toolbars visible on the CADFEKO window at startup. For a
detailed discussion of each one, please refer to the CADFEKO section of the FEKO user
manual. Since the geometry is already created for this example, the two toolbars on
the extreme left won’t be used. The toolbar immediately above the 3D view controls
properties that are associated with the 3D view, such as workplane settings, and settings
controlling the visibility of different features of the geometry. Above this toolbar is the
selection toolbar, which controls the way that items are selected from the 3D view. It is
also used to control which features (faces, edges, etc.) are selected. Also visible is the
contents tree on the left hand side, and the details tree below it. The message window is
directly below the 3D view of the horn.

The seperators between the different areas of the screen can be dragged to resize areas
as desired. The model can be rotated by using the mouse, left clicking and dragging.
The zoom factor is changed by rotating the mouse wheel. Pressing the mouse wheel and
dragging pans the model. This mouse behaviour is common to both POSTFEKO and
CADFEKO.

Context sensitive help is available in CADFEKO by pressing <F1> at any time.
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3.2.1 The contents tree

The contents tree is located to the left of the 3D view. It contains a history of the geometry
creation process as well as the resultant mesh information and any variables/named points
that were used during the creation process.

• The Variables branch contains all the variables used in this model. In this case the
only variables are the default variables.

• The Named points branch contains named points used
in the model - there are none for this example.

• The Media branch lists all available media that can
be used in this model. In this case, the only available
media are free space and solid metal.

• The Geometry branch contains the history of the
geometry creation. In this case, the geometry tree
contains one part named horn (a part is anything on
the first level of the Geometry branch). This part was
made of three child parts, namely Flare1, Cuboid1 and
Polyline1. All of these items are primitives, meaning
that they have no child parts.

• The Mesh branch contains all the mesh items in the model. Any meshes created
from geometry or imported meshes will be shown in this branch. The name of the
mesh is referred to as its label. In this case, there is only one mesh, with the label
horn.

It is possible to edit items by selecting them either in the 3D view or in the contents tree.
In some cases, the contents tree must be used. For instance, to change the length of the
flare, simply double-click on the Flare1 primitive in the tree - it would not be possible
to select the flare in the 3D view, since it doesn’t exist there anymore. The dialog that
was used to create the flare initially is opened for editing. If any values are changed, the
contents tree is re-evaluated, applying the changes further up the tree.

3.2.2 The details tree

When a part or a mesh is selected in the contents tree, some additional information is
shown in a tree positioned just below the contents tree. This is known as the Details tree.

If horn is selected in the Geometry branch of the contents tree, note that the details
tree contains a tree with two branches, namely Faces and Edges. If the geometry had
contained a volume, a Regions branch would also be visible. By selecting edges, faces or
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regions in this tree, local properties (like mesh size) can be set. Note that in this case
one of the edges is named feed.

If horn is selected in the Meshes branch of the contents tree, note that the details tree
contains a branch called Labels. This tree contains all the subsets of the horn that can
be individually isolated during later processing. For instance, the tree contains the label
feed. This means that there is a label horn.feed that can be used to uniquely identify the
segment that is used for the excitation.

3.3 Setting the solution control

The solution parameters are defined by high level commands or cards — just lines of text
— in the *.pre file. This text file may be created with any editor, but the customised
editor EDITFEKO simplifies this process. To start EDITFEKO, select Run → EDIT-
FEKO from the main menu in CADFEKO. EDITFEKO now shows the horn.pre file
that controls the model.

Each line of the *.pre file represents a specific command to the FEKO solver. These
commands are given in a column or colon delimited format. The format of the command
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does not need to be understood by the user to use the program. To modify a command,
simply move the cursor to that line and press <F1>. A panel will open on the left side of
the window. The panel is used to edit the command in a user friendly way. The command
name is given by the first two letters of each line. The commands used in this example
are:

• ** This is not a command - it is a comment that can be inserted anywhere in the
file to describe the solution control.

• IN This command instructs the solver to retrieve the mesh information that was
saved by CADFEKO.

• SF This command tells the FEKO solver that all dimension related values should
be scaled to get them into meters. In this example, all dimensions are entered in
centimeter, so the scale factor should be 0.01.

• EG This command seperates the the geometry related information (above the com-
mand) and the control information (below the command.

• FR A number of different types of frequency solutions can be selected. This com-
mand specifies the method that should be used, and any parameters associated with
it. In this case, a single frequency calculation is requested.

• A1 Each excitation type in FEKO is designated with a command starting with an
A. An A1 type excitation specifies the voltage over a specified segment. In this case
the segment with the label horn.feed is used, and a voltage of 1 is set.

• FE This command instructs the solver to calculate near field results. The required
coordinates for the calculation must be specified. A number of options, including
coordinate system choice and field type choice, can be selected on the panel. In this
case, a plane of near fields is requested in the opening of the horn. Both E and H
fields are calculated.

• FF This command is used to instruct the solver to calculate the radiated or far field
pattern of the antenna. This must always be in spherical coordinates. In this case
a full 3D pattern is requested.

• EN The last command is to let the solver know that the model is now complete.

The commands are executed sequentially. Certain commands result in a set of commands
being run in a loop. More information can be found in the user manual. Note that if no
field, current, coupling or other result is requested, FEKO will not solve the model, as no
output is requested. The geometry can also be specified in terms of commands.
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3.4 Obtaining a Solution

In this example, the solution is provided to save time. Ordinarily, once the model prepa-
ration is complete (Geometry, mesh and control), the pre-processor PREFEKO is run.
This program interprets the model and prepares it for solution by the FEKO solver. This
interpreted model is stored in a *.fek file. It is this file that is displayed by POSTFEKO.

Once the *.fek file is created, the FEKO solver can be run. If the FEKO solver is run
from one of the GUI components, and one of the model input files has been changed,
PREFEKO will be automatically launched before solving the model.

More comments on obtaining a solution can be found in the The program FEKO chapter
of the User Manual.

3.5 Viewing the model and results

The POSTFEKO component of the FEKO suite is used for model validation (the process
of checking that the simulated model represents the intended model) and result visuali-
sation. To launch POSTFEKO, select Run → POSTFEKO from the menu bar in either
CADFEKO or EDITFEKO.

POSTFEKO also makes use of the standard Windows look and feel, making it intuitive to
use. Similarly to EDITFEKO, POSTFEKO has a control panel to the left of the 3D view.
This panel is used to configure the current view. Many different types of results can be
visualised, meaning that many configuration options are needed. The options are grouped
by basic functionality. The toolbar on the far left is used to select a group of options
to set for the 3D visualisation window. The toolbar to the right of the view is used to
control the view camera. The toolbar above the view is used to add 2D result visualisation
windows to the current session or to launch one of the other FEKO components.

3.5.1 Model validation

Many models require significant computational resources to solve. It is therefore a good
idea to check that the model was correctly specified. POSTFEKO has features for this
task, collectively referred to as model validation tools. The two tools that will be used to
validate this model are the Show excitation and the Display requested field points tools.
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Select the Show excitation button on the left side
toolbar. Rotate and zoom in the 3D view so that
feed probe is visible. (Alternatively, the cutplanes
option on the left toolbar can be used to ’cut’
through the mesh to see the feed probe.) The
first segment (connecting the waveguide wall to
the remainder of the probe) will have a red arrow
on it indicating the location of the source.

Return to the default zoom and model
orientation. Select the Display requested
field points button on the left hand tool-
bar. The requested near field points are
shown using yellow crosses, and the re-
quested far field points are shown with
green crosses. Note that although the far
field points are shown in the vicinity of
the antenna structure, they are computed
in the far field. They are displayed close
to the antenna for convenience purposes
only. Uncheck the Visible checkboxes to
hide the requested field points.
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The last step in the validation
process is to visually check the di-
mensions. It is a good idea to
switch on a measurement grid to
check that the geometry size is
roughly correct, in case mistakes
were made when scaling the model.
To turn on a measurement grid, se-
lect the Axis settings button on the
left toolbar. In the Grid options
group, select a XY grid, and adjust
the position slider until the grid is
roughly coincident with the horn
aperture. Once the size has been
checked, the grid can be switched
off by un-selecting the checkbox.

Model validation is now complete. Note that these steps are not compulsory, they are
simply good modelling practice.

3.5.2 Near field results

The near field calculation that was requested earlier in this example has been performed
and stored. To display this data in the 3D view, select the View Near field ortho slices
button on the left toolbar. Note that the control panel contains many customisation
options.

For the purposes of this example, the magnitude of the Ey component of the field should
be displayed in dB, together with a legend and a few contour lines.
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In the Component group, the X and Z
components should be de-selected. The
dB button should be selected in the
Scale group. The Legend list is located
at the very bottom of the configuration
panel. Select Top Left from this list. To
place the contour lines onto the display,
select the Options tab. Fill in 11 for the
number of contours. The contour lines
now correspond to the values in the leg-
end.

The near field results can be shown on a 2D graph for comparison purposes, or for
quantitive results that are easy to read. The Add a near field graph button on the task
bar located above the 3D view is used to request such a plot. For the purposes of this
example the Ey and Ex component of the field through the centre of the horn in the y
direction will be plotted on the same set of axes, for comparison purposes.

When the Add a near field graph button
is pressed, a default plot line is made.
From the default view, change the com-
ponent to Ey, the independent direc-
tion to Y and the X position to 0.0. The
Ey component will now be shown.
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To add the second trace to the graph,
the New series button at the top of the
panel should be used. When this but-
ton is pressed, a second tab is added
to the panel. Select the series 2 tab to
change the settings for the second trace.
Change the settings in the Component
group to X only to display the Ex com-
ponent of the field. Change the inde-
pendent direction to Y and set the X
position to 0.0.

There is a vast difference in the mag-
nitude of the two components. Plot-
ting these results in dB would greatly
aid visualisation. In order to plot the
field values in dB, the settings for the
left axis must be changed. Select the
Left axis button to change these set-
tings. Select the dB option on the con-
figuration panel to change the setting.
Other settings relating to the appear-
ance of the graphs can be changed by
selecting the appropriate configuration
panel.

3.5.3 Far field results

The far fields on a full sphere are requested in the solution control phase of this example.
This section explains the procedure to plot these results in the 3D view, and on a 2D
graph.

In order to display the results in the 3D view the 3D view must be the active window.
Select this window from the Windows menu item in POSTFEKO. Select the View 3D
far fields option on the left side toolbar to display the far fields. Note that the fields
are immediately displayed, and that the configuration panel on the left lists options for
this display. On the configuration panel, are two tabs - one to control the displayed data,
and the other to change the way the data is displayed. On the Data tab, the displayed
quantity can be chosen from the Quantity group. Select Gain from this group. The dB
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option from the Scale group is selected to display the gain in dB. To set the range of the
displayed result, select the Manual limits checkbox and enter values for the minimum and
maximum values of the display. In this case, a minimum of -20dB and a maximum of
17dB is set. At the bottom of the panel the legend display is chosen from the drop-down
list. On the Options tab, the size of the plot can be changed. Move the Scale factor slider
until the field results are reasonably sized, compared to the geometry size.

Far field radiation patterns are often displayed on 2D polar graphs. Since full 3D data is
requested in this simulation, 2D cuts can be extracted. To open a new 2D graph, select
the Add a far field graph button from the toolbar above the 3D view.

In this case, it is requested that the far field gain be plotted in the YZ plane on a polar
graph. This corresponds to plotting the data with respect to theta at phi = 90◦. The
data should be plotted in dB, using a data range of -20dB to 20dB.

In the Independent variable group, theta
should already be selected. The value of
phi to be used (90◦) is selected from the
drop down list below the name. Gain is se-
lected from the Quantity group. Select the
Graph settings button on the left toolbar
to set the Plot type to Polar. Take note of
the other setting that are controlled from
this panel.
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The radial axis settings are now con-
trolled by the left axis settings panel.
Select the left axis button from the left
toolbar. Select the dB scaling option.
Note that the autoscale already selects
the correct range for this example.

3.6 Closing remarks

This introductory example has shown aspects of the user interface of FEKO, from pre-
processing through to post processing, using an already set up model of a horn antenna.
The horn geometry is entered (with a detailed explanation in the FEKO demo file). The
control specification for the frequency, excitation, request of near- and far- field data
calculation is discussed together with EDITFEKO. The display of the simulated model,
together with results is explained in detail.
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4 Getting started example 2: Patch antenna example

The second example introduces dielectric material into the model and sets local mesh
properties. To illustrate the use of dielectric regions, a patch antenna on a substrate is
used. Dielectric material modelling in FEKO is not restricted to planar antenna mod-
elling. Dielectric regions of arbitrary shape and dielectric parameters can be used.

The example covers all phases of the modelling process. This necessarily means that
all phases must be executed sequentially. It is not possible to only work through one
subsection of this example. This example will take approximately 60 minutes to work
through.

4.1 Example overview

The input impedance over frequency of a resonant patch antenna is investigated close to
resonance. The patch (31.1807mm by 46.7480mm) is printed onto a finite sized substrate
(50mm by 80mm) with a thickness of 2.87mm. The relative dielectric constant of the
substrate is 2.2. The patch is fed with an SMA connector (pin diameter 1.3mm) located
8.9mm from the centre of the long edge. The only observable of interest is the input
impedance over the band 2.6 GHz to 3.1 GHz. Adaptive frequency sampling will be used
to reduce the number of frequency samples in the band.

4.2 Creation of the geometry in CADFEKO

The first step in every FEKO solution is to construct the geometry. The geometry is
created by the component CADFEKO and stored in the *.cfx file. To start CADFEKO
from the Windows Start menu, choose

Programs → FEKO → CADFEKO
or open a console window and type cadfeko.

CADFEKO will start with a blank project. When enetring entities, all dimension related
values will be entered in mm. For simplicity, the model will not use any variables or
parameters.

The substrate is modelled using a cuboid. A polygon is drawn to represent the patch
surface. A wire element is drawn to model the feed pin. Properties for the substrate and
local mesh settings are then set.
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The first step is to draw the cuboid. Select the
Cuboid button on the extreme left to open the Create
cuboid panel. All items are drawn in global coordi-
nates for this example. If the dialog is shown in terms
of U-V-N coordinates, please change the Default lo-
cal coordinates setting to Global in the Options →
Preferences dialog.
Enter the coordinates as shown on the left. Notice
that the cuboid is made with a negative height, since
the top corner of the cuboid should be coincident
with z = 0 plane. Close the dialog after creating
the cuboid. Press the Zoom to extents button on the
toolbar located immidiately above the 3D view to
zoom out so that the substrate can be seen.

Next, the surface of the patch is drawn with a poly-
gon. To draw a polygon, select the Create polygon
button on the leftmost toolbar. This opens the Cre-
ate polygon dialog. Enter the values as shown on the
left. Note that the Add button should be pressed
to add a fourth corner to the polygon. The coordi-
nates for the polygon are entered using expressions
to make it easier to understand how the enetered
values are calculated. Close the dialog after creating
the polygon.
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The only part of the geometry that still needs to
be drawn is the wire. Select the line button on the
leftmost toolbar. The wire is positioned 8.9mm from
the edge of the long side.

The position of the feed needs to be uniquely identifiable. The name of the edge to
be excited must be set so that this name can be used to identify the segment to the
FEKO solver. In this case the wire will be shorter than the segment length, meaning
that the meshed model will have only one segment. If this is not the case, a seperate
wire should define the feed segement. See the first and third getting started example for
demonstrations on how this is achieved using a polyline entity.

Select the part pin in the geometry tree. Note
that the detail tree (directly below the geometry
tree) contains an Edges entry, with one child, named
Wirexx where xx is a number. Select this wire, and
press F2 to rename this wire, and rename it to feed.

To ensure proper connectivity between these separate parts, they must be joined together.
This process is called unioning. Select all three parts in the geometry tree and then select
the Union parts button from the toolbar to the immediate left of the geometry tree. Note
that a new level is now created in the geometry tree, with the three parts as child parts.
Select this new part, and press <F2> to rename it. Change the name to patch. Note that
the edge corresponding to the feed wire retains the name change previously specified.
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If the structure was to be meshed at this stage, CADFEKO
would assume all structures to be metallic. Since this is not
the case, the properties of the region must be set. Before
the substrate medium can be used in for the region, it must
be defined in the Media branch of the content tree. Double
click on the Media label in the contents tree to create a
new medium. Name the new medium substrate. To set the
properties of the interior region of the model, select the part
in the geometry tree. The detail tree now shows a Regions
branch. Expand this branch to see a list of available regions.
In this example, only one region (the inside of the cuboid)
exists. Right click on this region, and select Properties.

Select Dielectric from the first drop down list in the
Medium group. In this case, the medium substrate is
the only defined dielectric medium, and will be se-
lected by default in the second drop down list. Note
that the electromagnetic properties of this region are
not set at this stage. The icon next to the part in
the geometry tree will change, signifying that the
part contains a dielectric region.

If the structure was to be meshed at this stage, none of the surfaces of the dielectric
region would be have a metallic coating. Two of the surfaces, namely the patch and the
groundplane, should be marked as metal. To select these surfaces, switch to face selection
mode by pressing the Select faces button from the selection toolbar. Select the patch
surface in the 3D view. Right click on it and select Properties. Check the Metal surface
checkbox and press OK. Note the icon change in the details tree. Repeat this process
for the groundplane. (The faces can be selected simultaneously, and their properties set
simultaneously.)

The geometry creation is now complete. Save the model before proceeding.

4.3 Mesh creation

The last step to be completed in CADFEKO is the mesh generation for the simulation.
For most models, a constant mesh size of λ/10 is preferred (where λ is the free space
wavelength). When a model contains dielectric materials, a mesh size for all triangles
that have at least one side on the surface of the dielectric, a mesh size of λd/10 should
be used (where λd is the wavelength inside the dielectric). These rules are generally
applicable, but shouldn’t be applied blindly. A denser mesh should be used where the
current is known to vary more quickly, and a less dense mesh can be used when some
modeling approximations are suitable. Refer to the General comments section of the
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FEKO user manual for more information regarding mesh size guidelines. In this example,
the current is known to vary more quickly near to the long edges of the patch - making
these a good candidate for finer meshing. A mesh density of λd/12 will be used as the
general mesh size, with a finer mesh along the two long edges of the patch, of λd/18. Both
of these mesh sizes are denser than the recommended guideline because of the thickness
of the substrate.

To set the mesh size along the two edges of inter-
est, switch to edge selection mode by clicking on the
Select edges button on the selection toolbar - the top-
most toolbar on the CADFEKO window. Left click-
ing the mouse will now select edges - note the selec-
tion shown in the detail tree. Select one of the long
edges of the patch. Right click on either the edge,
or the corresponding entry in the detail tree, and se-
lect Properties. Select the Local mesh size checkbox
and enter a mesh size of 3.7mm into the edit box.
The same should be done for the other long edge.
(Note that the properties for both edges can be set
simultaneously by selecting both edges.)

Now that the local mesh properties have been set,
the geometry can be meshed. Select Mesh → Create
mesh from the CADFEKO menu bar. The global
mesh size for triangular and wire elements should be
set to 5.6mm. The radius of the feed pin is 0.65mm.
All other options should be left as is for this example.
Select Create to create the mesh. Note the finer mesh
along the long edges.
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The mesh of the model is now complete. The model should be saved in CADFEKO at
this point.

4.4 Setting the solution control

The next step in the simulation procedure is to set the model parameters, such as fre-
quency range, excitation, dielectric parameters and required observables. Parameters are
set using the EDITFEKO user interface. In this example, adaptive (continuous) frequency
sampling will be used, and the input impedance will be extracted.

EDITFEKO can be launched directly from the CADFEKO user interface. Select Run →
EDITFEKO from the menu bar to launch the user interface.

As described in the preceding example, the model control is specified using a series of
sequential commands. The first two characters of each line specify the command, and
the parameters for the command are set in the configuration panel on the left. To open
the configuration panel for a specific command, place the cursor on the same line as the
command, and press <F1>.

The first line of the standard control file starts with two asterisks. This means that this
line is not a command, rather a comment. Anything after the two asterisks is ignored by
FEKO.

The first command in the standard file is the IN command. This command instructs the
solver to extract the mesh information from the CADFEKO output. This command can
be left in the default configuration for this example.

The first command that should be en-
tered is the SF command. This com-
mand instructs FEKO to accept all di-
mension related values in millimeters.
To enter this command, position the
cursor on an empty line below the IN
command, and above the EG com-
mand. Then press the SF button lo-
cated on the left side of the text area.
A scale factor of 0.001 should be entered
into the Multiply dimensions with edit
box. Press OK.
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The dielectric properties of the substrate have not
yet been set. The parameters are set using the DI
command. Position the cursor below the EG card,
and press the DI button to the left of the text area.
This opens the configuration panel for this command
on the left of the text area. Enter the relative permit-
tivity and permeability of the substrate. Note that
the name given to the dielectric region in CADFEKO
must be used in the Set properties for medium edit
box. Press OK.

Frequency control for the model is set using the FR
command. This command is already inserted into
the default control parameter file. To edit the com-
mand, position the cursor on the same line as the
current FR command, and press <F1>. This opens
the configuration for the existing command, rather
than inserting a new command. Choose Continuous
data (adaptive sampling) from the three different fre-
quency sampling modes. Set the maximum number
of samples that the adaptive method can use to 21.
Set the frequency range to start at 2.6GHz and to
end at 3.1GHz. This command now instructs the
FEKO solver to sample the frequency at optimal lo-
cations in the band. More information about this
method can be found in the ADAPTFEKO section
of the user manual.

The model, now complete with dielectric parame-
ters and frequency specification, still requires an
excitation to be set. Position the cursor below
the ** Set source comment. Press the A1 button
on the left of the text area. The configuration
panel for an A1 source type will open on the left.
This source type is used to specify a voltage ex-
citation over a wire segment. More information
about this and other excitations can be found in
the user manual. The label of the segment to
feed is patch.feed — this should be entered into
the Apply source to last segment with label edit
box. Since input impedance is the only observ-
able of interest, the voltage specification will not
influence the result. Therefore a value of 1V with
0◦ phase is specified.
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The model is completely specified at this point,
but no output is requested. FEKO will therefore
not solve the model. The input impedance for
sources is calculated regardless of which compu-
tation instruction is given. In order to instruct
the solver to calculate the input impedance, we
use the command to calculate the currents in the
model. This command is the OS command. Po-
sition the cursor below the ** Solution control
comment and press the OS button on the left of
the text area to open the configuration panel for
the command. Select the No currents option on
the panel. In this configuration, the FEKO solver
will calculate the currents, and therefore the in-
put impedance, without writing all the currents
to the output file — which could result in a very
large output file.

The solution control parameters are now completely defined. The control specification
script should now look like this:

** PREFEKO input file generated by CADFEKO

** Import model
IN 8 31 "patch.cfm"
SF 1 0.001
** End of geometry
EG 1 0 0 0
DI: substrate : : : : : 2.2 : 1.0
** Set frequency
FR 21 2 2.6e9 3.1e9
** Set source
A1: 0 : patch.feed : : : : 1 : 0
** Solution control
OS 0
** End of file
EN

** CADFEKO Checksum: 3a5792486fd158826e2ee87f4196cb70

The solver does not interpret these commands directly - a pre process step is still required.
To pre-process the model, simply select Run → PREFEKO from the EDITFEKO menu
bar. PREFEKO interprets the model and commands into a low level format that is used
by the solver. After running PREFEKO, the model is ready to be solved.
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4.5 Obtaining a solution

After completing the model preparation, the solver should be invoked to calculate the
requested results. The solver can be invoked in a number of ways, from a command
window or from any one of the GUI components. In this example, the solver will be
invoked from EDITFEKO.

At this stage of the solution process, it is advisable to perform model validation, as
described in the first getting started example. In this case it is advisable to check that
the metalisation of the patch and groundplane surfaces was correctly performed and that
the scaling was correctly applied. To create the model from the script, select Run →
PREFEKO from the EDITFEKO menu bar.

To invoke the solver from EDITFEKO select Run → FEKO from the menu bar. A window
will open, giving step by step feedback as the simulation progresses. The solver will use
6 frequency samples in the band. The simulation time should be between 70 and 100
seconds per frequency, depending on the processor speed of the computer. Peak memory
utilisation should be of the order of 140MByte. The simulation time and peak memory
usage could be reduced significantly by exploiting the magnetic symmetry of this example.
See the discussion on the use of symmetry in the FEKO user manual.

4.6 Visualisation of results

To launch POSTFEKO, select Run → POSTFEKO from the EDITFEKO menu bar.
POSTFEKO will open, with the patch antenna in the 3D view. POSTFEKO is used for
all post processing operations, including the plotting of input impedance versus frequency
as needed in this example.

A new graph that plots information relating to the source is started by pressing the Add
a source data graph button on the 2D graphing toolbar. (This toolbar is located above
the 3D view.)

A default graph of input impedance versus frequency is opened with the input impedance
at the first frequency sample point displayed. Continuous frequency sampling is used for
this example, meaning that the solver automatically chooses the frequency sample points.
The sample points that were chosen can be seen in the list on the configuration panel.
Below this list is a check box labelled Use continuous frequency. Select this checkbox
to plot the results as calculated by the adaptive process. The magnitude of the input
impedance over the entire frequency range will be shown. The sample points (the exact
frequencies at which a solution was obtained) are shown with markers. Select Real in the
Part group to plot the real part of the input impedance rather than the magnitude. To
add another trace (for the imaginary part of the impedance) select the New series button
located on the toolbar at the top of the configuration panel. A second tab named series 2
will be created on the configuration panel - select this tab.
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Turn on the continuous frequency sampling by checking the Use continuous frequency
check box. The second trace will now be visible, showing the magnitude of the input
impedance. Select Imag from the Part group to change this trace to display the imaginary
part of the input impedance.

The input impedance characteristics of the patch antenna are easily accessed from this
graph. The graph can be customised using the settings panels available using the buttons
on the toolbar to the very left of the window.

4.7 Closing remarks

A rectangular, pin fed, patch antenna on a finite sized dielectric substrate is simulated.
The real and imaginary parts of the input impedance are plotted versus frequency in the
band of interest.

The geometry is drawn entirely in CADFEKO. Three key steps are the setting of the
region properties for the substrate, setting the label of the feed segment and setting the
local mesh properties along two of the edges.

The model control script is specified using the EDITFEKO user interface. The mesh is
imported, a scale factor specified, substrate properties set, excitation specified and output
requested.

The results are visualised using the POSTFEKO user interface.
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5 Getting started example 3: EMC coupling Example

5.1 Example overview

This example considers the coupling between a typical HF monopole antenna and a
loaded transmission line as shown in figure 5-1. Both the antenna and the transmission
line consist of wire conductors, which are long compared to their diameters.

50 mm

12 m2 m

12 m

diameter = 8 mm

diameter = 30 mm

P = 1 W
in

~

R = 1k�

Figure 5-1: Sketch of the model

The example illustrates how to use the BO card to simulate a perfectly conducting infinite
ground plane. Loading of a segment with a complex impedance will be shown. Working
through this example should require about 70 minutes.

5.2 Creation of the geometry in CADFEKO

The first step in every FEKO solution is to construct the geometry. The geometry is
created by the component CADFEKO and stored in the *.cfx file. To start CADFEKO
from the Windows Start menu, choose

Programs → FEKO → CADFEKO
or open a console window and type cadfeko.

In contrast to the preceding examples, all dimension related values will be enetered di-
rectly in meters.

Both the monopole and the transmission line are created using polyline entities. The
groundplane is defined as part of the control section in EDITFEKO - this is because the
presence of a infinite groundplane changes the formulation used in the solver. The same
is true of infinite planar or spherical Green’s functions. (See the GF card entry in the
user manual for more information regarding the use of this feature.)
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The first step is to draw the monopole along the pos-
itive z-axis. Press the Polyline button on the geome-
try creation toolbar. A third point should be added
to the polyline, so that a separate feed segment can
be created. The feed segment is created as 100mm
long - this is more than 3 times the diameter of the
wire. If the feed segment is specified too short com-
pared to the diameter of the wire, FEKO will give a
warning. More information about this can be found
in the General Comments section of the user manual.
Note the specification of monopole as the name for
this part. After creating this part, press the Zoom
to extents button on the toolbar immediately above
the 3D view.

The transmission line is created using the same dia-
log as the monopole creation. The transmission line
is created along the y-axis. Note the naming of the
polyline to Tline. Press the Zoom to extents button
on the toolbar above the 3D view to get the structure
to fit inside the 3D view.
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The feed segment of the monopole should be re-
named, so that the label of the element can be easily
identified to the FEKO solver. Open the Edges tree
in the detail tree of the monopole. Select the edge
corresponding to the feed segment, and press <F2>
to change the name to feed.
The radius of the two structures (monopole and
transmission line are not the same. A global wire ra-
dius cannot be used. Select both edges in the detail
tree of the monopole. Right click and select Proper-
ties. On this dialog, the wire radius can be set. Set
the radius to 0.015m.

The load segment of the transmission line should be
renamed, so that the label of the element can be eas-
ily identified to the FEKO solver. Open the Edges
tree in the detail tree of the transmission line. Select
the edge corresponding to the load segment (chang-
ing the zoom may be required for this), and press
<F2> to change the name to load.
The global wire radius will be set at a later stage
equal to that of the transmission line (4mm). It
is therefore not necessary to set the wire radius for
these edges at this stage.

The geometry of the problem is now completely defined. The next step is to create a
mesh for the structure. It is advisable to save the example at this point.
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5.3 Mesh creation

The global edge length is set to 0.5m. This mesh size
is quite fine, considering that the highest frequency
of the solution will be 30 MHz - or a wavelength of
10m. In this case, resources will not be a problem, so
over discretisation is not a problem. The global wire
radius is set to that of the transmission line - 4mm.
The wire diameter for the monopole is set locally and
will override this value.

At this stage, the geometry is completely defined and meshed. The only further require-
ment is the model solution control script. Save the model before continuing.

5.4 Setting the solution control

The next step in the simulation procedure is to set the model parameters, such as fre-
quency range, excitation and required observables. Parameters are set using the EDIT-
FEKO user interface. In this example, adaptive (continuous) frequency sampling will be
used, and the currents on the structure will be extracted.

EDITFEKO can be launched directly from the CADFEKO user interface. Select Run →
EDITFEKO from the menu bar to launch the user interface.

As described in the first example, the model control is specified using a series of sequential
commands. The first two characters of each line specify the command, and the parameters
are set in the configuration panel on the left. To open the configuration panel for a specific
command, place the cursor on the same line as the command, and press <F1>.

The first line of the standard control file starts with two asterisks. This means that this
line is not a command, rather a comment. Anything after the two asterisks is ignored by
FEKO.
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The first command in the standard file is the IN command. This command instructs the
solver to extract the mesh information from the CADFEKO output. This command can
be left in the default configuration for this example.

The first command that should be added is the BO
command. This command instructs the solver to
place a reflective ground at the z = 0 plane. Place
the cursor on the line below the EG command and
press the BO button on the panel on the left. Select
the Perfectly electric conducting groundoption.

The next command is the LZ command, which is
used to specify the load on the terminating segment
of the transmission line. Place the cursor on the line
below the BO command and press the LZ button on
the panel on the left. Specify the Tline.load label,
and a real impedance of 1000 Ohms.

The existing FR command should be edited to set
the frequency range for the simulation. Position the
cursor on the line containing the FR command and
press <F1> to edit this command. Continuous fre-
quency sampling should be used, with a maximum of
91 frequency samples between 1 MHz and 30 MHz.

The excitation is set using the A1 command.
Position the cursor below the ** Set source
comment, and press the A1 button on the left
side of the screen. This opens the dialog to
edit the A1 command. The label for the feed
segment should be set to monopole.feed. The
radiated power will be controlled with another
command, so any value of voltage can be used
in this command. A setting of 1 is typically
used.
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The second last command used in this ex-
ample is the PW command. It instructs the
FEKO solver to scale the amount of radiated
power. Position the cursor below the ** Solu-
tion control comment, and press the PW but-
ton on the left. Select the Total source power
(no internal impedance) option. (More infor-
mation on the difference between these power
specification options can be found in the user
manual.) Set the total value for the power to
1W.

The last command required in this example is
the OS command. This command instructs
the FEKO solver to calculate the currents
along the wires, and save this solution in the
FEKO output. Select the All currents option
on this dialog.

The solution control script is now complete. The file should look as follows:
** PREFEKO input file generated by CADFEKO
** Import model
IN 8 31 "coupling.cfm"
** End of geometry
EG 1 0 0 0
BO 2
LZ: Tline.load : : : : : 1000 : 0
** Set frequency
FR 91 2 1e6 30e6
** Set source
A1: 0 : monopole.feed : : : : 1 : 0
** Solution control
PW 1 0 1
OS 1 1
** End of file
EN
** CADFEKO Checksum: eb9165c1df57b096f2cd094bfd25f236
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5.5 Obtaining a solution

The model input has been prepared, and the FEKO solver should be executed to produce
the requested output (current along the wire).

To launch the solver from EDITFEKO, select Run → FEKO from the menu bar. The
preprocessor, PREFEKO, will be launched automatically.

The solver requires 40 frequency samples and a maximum memory usage of around 70
kByte.

5.6 Visualisation of results

At this stage, the entire model has been set up and solved. The only remaining step is to
visualise the result.

Result visualisation is done in POSTFEKO. POSTFEKO can be launched from EDIT-
FEKO by selecting Run → POSTFEKO from the menu bar. A POSTFEKO window will
open, showing the geometry in the 3D view. To show a graph of the current in the
load on the transmission line, select the Add a currents and charges graph button on the
toolbar above the 3D view. From the configuration panel on the left, the Use continuous
frequency check box should be selected. The Tline.load label should be selected in the
Label group box. Note that there is only one segment on this label. If multiple segments
were present on the label, the target segment would need to be identified in the 3D view.
See Picking in the POSTFEKO section of the user manual for more information.

Select the Left axis button to open a configuration panel to change that axis’ setting.
Change the scaling to dB.

The steps shown in the second example for plotting of input impedance can be repeated
in this example to show the input impedance for the monopole.
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5.7 Closing remarks

This example has shown the set up and solution of an EMC coupling problem. The
problem description is of a monopole antenna and transmission line on an infinite perfectly
electrically conducting ground plane. Coupling of current into the transmission line is
shown from 1 MHz to 30 MHz.

This example used a special formulation for the consideration of the infinite ground plane.
This formulation is activated from the solution control script.
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6 More examples

This ends the getting started examples for FEKO. During installation, a number of
examples have been copied to the directory examples under the FEKO home directory.
These are described in the Examples Guide.

You will need to run PREFEKO before you can view the geometry as no *.fek files are
included in the installation. The FEKO solver will need to be run before any results can
be visualised, since no *.bof files or *.out files are included in the installation.
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FEKO, 1-2
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floating licences, 2-8
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import
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load, 5-5
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name, 5-3
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model
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model validation, 3-6
monopole, 5-1

Named points, 3-3
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display of, 3-8
requesting a calculation, 3-5
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port, see excitations
POSTFEKO, 1-2, 3-6, 3-8, 3-10, 4-9, 5-7
power, 5-5
PREFEKO, 1-2, 3-6, 4-9, 5-6
printing user’s manual, 2-14
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result

display, 3-8, 3-10, 4-9, 5-7

scale factor, 3-5, 4-6
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SGI, 2-5
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solver
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substrate, 4-1
SUN, 2-5
system requirements

MS Windows, 2-2
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